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WARNING: Be careful when using your
camera and its accessories. Always be
cautious of your surroundings to avoid
injuring yourself and others.

Make sure to follow all local laws including
all privacy laws which may restrict recording
in certain areas.



IC warning:

This device contains licence-exempt transmitter(s)/receiver(s)/

that comply with Innovation Science and Economic Development
Canada's licence-exempt RSS(s). Operation is subject to the
following two conditions:

1. This device not cause interference.

2. This device must accept any interference, including interference
that may cause undesired operation of the device.

Radiation Exposure: This equipment complies with Canada

radiation exposure limits set forth for an uncontrolled environment.
To maintain compliance with IC's RF Exposure guidelines, this
equipment should be installed and operated with minimum distance
of 20cm the radiator your body. This device and its antenna(s) must
not be co-located or operation in conjunction with any other antenna
or transmitter.

Déclaration de I'ISED Canada:

Cet appareil contient des tasmittre (s) / récepteur (s) sans licence /
conformes a l'innovationRSS exemptes de licence de Sciences et
Développement économique Canada. L'opération est sous réserve
des deux conditions suivantes:

1. Cet appareil ne peut pas causer d'interférences et.

2. Cet dispositif doit accepter toute interférence, y compris peut
provoquer le fonctionnement indésirable de |'appareil.

Exposition aux rayonnements: Cet équipement est conforme aux
radiations du Canada limites d'exposition pour un environnement
incontrélé noncé d'exposition RF Pour maintenir le respect des
guides d'exposition RF d'IC, cquipment doit étre.installé et actionné
avec une distance minimale de 20cm le radiateur de votre corps.
Cet appareil et ses antennes ne doivent pas étre co-localisé ou en
opération en conjonction avec toute autre antenne ou émetteur.
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NOTES
——— =

NOTES Before Installation

Do not directly plug and unplug the cable or SD card, please
perform related operations after camera off.

Do not expose to the sun for a long time is the best, camera will heat
on during its working, any damaged by high temperature will be
added to 1 year free replacement warranty.

Please use the cables and accessories provided in the package.

Please plug in all accessories and power the dash cam to confirm
whether it can work well before installation.

If you encounter any problems, please feel free to contact our
customer service.
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What In Box?

T27 Mirror Dash Cam

g

. Backup Camera «
GPS Receiver Cable *1 Car Charger *1

-~
173
3M Sticker*1

Mount Bracket*1
Screws *4
(Inside of Vehicle)

Backup Camera *1 Straps *4

Cleaning
Cloth *1

User Manual*1| Tool *1 Cable Straps*5




Mounting the Mirror
——— =

Step 1: Pull out the lens of the T27 dash cam to match the rearview
mirror of the vehicle.

Step 2: Extend the straps around the back of the rear-view mirror
and attach them to the bottom retaining hooks.
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Mounting the Mirror
——

Step 3: Power on the dash cam with box included car charger, don't
charge it with your own chargers.
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Mounting the rear camera
I e — et
Rear Camera Upgrade

New rear camera comes with a mounting bracket which supports
both interior and exterior installation.

Outside the car bracket

Adjustable angle Fixed angle, not adjustable Inside the car bracket

How to install the rear camera

We recommend installing the rear camera outside the car (above the
license plate). The effect of the rear camera inside the car may be
affected by the windshield.

1. Tear off the 3M adhesive of the rear camera (if you need to adjust
the angle of the camera, please stick the 3M adhesive on the iron
plate, if you don't need to adjust the angle, please stick it on the top
of the rear camera), and then fix the rear camera in the most suitable
position above the licence plate.
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Mounting the rear camera
—

2. Remove the Panel

Remove the inner panel of the trunk to
expose the rear wiring compartment of the
car. Open the trunk and look for a sturdy
inner panel covering the other side of the
license plate installation area. Then, insert
a decorative removal tool or another thin
device behind the panel and pry it apart.

3. Snake the cable

Use a trim removal tool to pop out tailgate
trim, then run the cable from outside of the
car into the trunk of your car.

4. After snaking your rear camera's
extension cable, connect the power cable
to your rear camera's extension cord.

NOTE:
If you need to install a trigger cable to activate the reversing guides,

please find the positive cable of reversing lamp and connect the red
wire from the rear camera, you can also ask a professional for help.
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Mounting the rear camera
—

How to install the rear camera in the car
Step 1: Confirm the accessories

1 in-car bracket
2 additional screws

Step 2: Remove the original iron plate.

Step 3: Install the two iron plates together and attach them to the
rear camera.
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Mounting the rear camera
—

Step 4: Stick the bracket to the rear windshield with 3M tape.

NOTE:

If your caris a RV or a pickup truck, you can install the rear camera
forward (the bracket is below), and turn on the "Upside down of
rear camera" and turn off the "Rear Cam" Mirror Image" to adjust
the image.If you need a license plate bracket, we also provide this
accessory, feel free to CONTACT US.
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Mounting the GPS

——— =

Installation location

Considering the use effect and installation convenience, we usually
recommend customers install it at the position specified in the
picture. Of course, you can also try to install it in other locations for
testing, and choose the location you think is most suitable.
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Mounting the GPS
—

FAQ

Q: Why is my GPS not working? /How to use GPS ?
A: If you cannot receive the signal after inserting the GPS, please
follow the steps below.

1. The vehicle must be within a large area.

2. Insert the GPS plug again.

3. Place the GPS plug upward.

4. Restart

5. It will be recognized after about 40 seconds. If still cannot receive
the signal, it may be a GPS problem. Please CONTACT US and we
will help you solve this problem.

11



Meeting Your T27
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NO. Name Description
1 Front Camera Record the front view of the vehicle.
2 GPS Port Connect the GPS receiver.
3 Micro SD Card Slot Insert a Micro SD card (Preferably with a 128G SD card).
4 Rear Camera Port Connect the rear view camera.
5 Power Supply Port Connect the car charger.
6 Fasteners Please use the included silicone straps.
7 Screen 11.26 inch IPS touch screen.
8 Power Button Short press to turn off the screen, long

press to turn off the power.
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Meeting Your T27

—— e

00:15 4k+2.5

/AN

south
0.0 MPH

/A Speed & Driving Direction: Once GPS is connected, the
=\ information will show
o Settings: Touch to enter the menu setting
P File Playback: Playback the video & Photo
(12 Start/ Stop Recording

Snapshot: Take a Snapshot

12:25

Date & Time

Recording Status: Yellow flashing means Lock Recording

Audio Record is on

Button's beep sound status

O e B>

GPS Status: Once the GPS signal is successfully received, the
icon will turn GREEN. Otherwise, it turns WHITE.
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T27 Power Tools
— =

1. Cig Charger

Note: It is best to use the power cord that comes with our products, or
our professional hardware kits.

2. Hardwire Kit

Note: Not included, need to be purchased separately.
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Setting Up Your Camera
——

SD CARD

With your camera off, insert the SD card into the card slot with the
label facing the back of your camera.

You can eject the card by pressing it into the slot with your fingernail.
You'll need a micro SD card (sold separately) to save your videos and
photos. Use a U3 Class 10 SD™ Card dedicated or your camera may
malfunction.

SD cards can degrade over time and affect your camera's ability to
save your media. Try swapping out an older card for a new one if
you're having any problems.

WIRING SET UP

Connect your camera to a Cig charger using the included cig charge
cable.

UPDATING YOUR CAMERA'S SOFTWARE

To get the latest features and best performance from your camera,
make sure it's using the most current software.

Visit - https://www.redtigercam.com/pages/firmware-1
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Setting Up Your Camera

00:15 4k+2.5

/AN

south
0.0 MPH

On the LEFT side of the screen: Slide up and down to adjust the
angle of view.

00:15 4k+2.5
/AN

south
0.0 MPH

On the RIGHT side of the screen: Slide up and down to adjust the
brightness.

00:15 4k+2.5

[\ 12:25

0.0 MPH

Anywhere on the screen: Swipe the screen left or right to switch
between front view, rear view, or split-screen view.
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Playback Your T27
——

Playback Mode

1. Normal Recording

00:15 4k+2.5 Y
/A 1225

Wednesday
south 2022-03-09
0.0 MPH

When you turn on the power, the dash cam will start recording
automatically.

Click | Jl to enter the playback mode.
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Playback Your T27
——

Playback menu

Normal Recording Emergency Recording

(M) Front Normal Album (@ Rear Normal Album
@ Front Urgent Album @ Rear Urgent Album
@ Front Photo @ Rear Photo
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Customizing Your T27
I e — et

When T27 Hardwire Kit is not connected

spitTime.

<)

Volume

&

2ehour

o

Spoed Unit
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Customizing Your T27
I e — et

Function Introduce
Resolution 4K+2.5K or 2.5K+2.5K
Spilt Time "Looping recording duration
1/3/5 min"
Sound Record | ON/OFF

G-sensor OFF/Low/ Middle/High

Sensitivity

Flicker 50HZ/60HZ

Screensaver "OFF-Screen always on

Mode Turn off screen-Screen off after
15s/1Tmin/3min
Time screensaver-Screen off after
15s/Tmin/3min"

Click Tone ON/OFF

Volume Mute/Low/ Middle/High Adjust the
camera volume

Screen Slide the screen to adjust the brightness

Brightness

Display Mode | Front/Rear/Preview Right/Preview Left

Rear image Rear Flip/Rear Mirror

Adjustment

Time Display ON/OFF
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Customizing Your T27
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Function Introduce
24-Hour Time format-12H/24H
Daylight ON/OFF

Saving Time

Time Format

"Change the time display method to
YY-MM-DD/DD-MM-YY/MM-DD-YY"

Reverse Mode

Full screen Display/Panorama Display

Fatigue Remind after long time driving
Reminder

Timezone Select Corresponding Timezone
Speed Unit KM/H or MPH

GPS Info Check GPS details

GPS Display ON/OFF

Language Select correct language

Format SD Delete all DATA in SD card

Reset Factory

Reset to initial settings

About

Check model & Version number

Help Center

Official website QR code
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Customizing Your T27
—— e

Reverse Mode

Full screen Display

00:41  2.5K+2.5K

©
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Customizing Your T27
I e — et

R After T27 dedicated hardware kit is connected, the icon
"enter time lapse" will occur on the screen.

Entering time-lapse...|

Collision Boot Recording

30 Seconds < m.ﬁﬁ
] T I
Car Crash
I | 20 Seconds I
Normal Recording Emergency Recording  Normal Recording

When a car is hit or rubbed, the G sensor detects the impact and saves the next 20
seconds of video (Urgent Album)

Working Process:G sensor detects vehicle impact — Power on — Emergency
video recording —> Power off
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Customizing Your T27
I e — et

Lapse Record

Collision boot recording @ Lapse Record

OFF
Low
Middle

High

® collision boot recording. Lapse Record

OFF

When you set the Lapse Record mode, the dash cam will continue to record
12H/24/48H after the vehicle is turned off.

How to set it up: clik into i > set Collision Boot Recording to OFF > click
Lapse Record > setthe recordlng time you want.
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Parking Mode ( Optional )
I e — et

INSTALL YOU HARDWIRE KIT

Red wire >>ACC >>> power only when car key is on
Yellow wire >> B+ >>> Always has power
Black wire >> Ground >>> Any grounded (neg) screw
1]
Engine key

fuse  Adaptive Accessory cods {rad)
=amame] Cruise Control

oo o | BATT
BATT Battery cord (yellow)
Main fuse
? Earth cord {black)

battery Connect to metal part of the fuse

box (Negative pole of power supply)

POP-UP: You could usually find your fuse box under the trunk or
steering device.

You could cut the head of wires and connect it to your fuse directly if
your fuses is small.

25



Parking Mode ( Optional )
I e — et

SELECT PARKING MODE

Professional installation of hardwire kit for T27, enter Parking Mode
In Settings.

Setting >> Parking Mode >> Collision Boot Recording/Lapse
Record.

COLLISION BOOT RECORDING

> Select Sensitivity

> Vehicle stalled

> Collision or vibration be detected

> An Unerasable record will be created in the Lock folder

TIME-LAPSE

> Select 12h / 24h / 48h

> A Record will be created in 1 fps during your parking time
> 1 min = actual 12 mins

> Collision or vibration be detected

> An Unerasable record will be created in Lock space
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GPS Player ( PC)

DOWNLOAD GPS PLAYER

Download our GPS Player from website:
https://www.redtigercam.com/pages/gps-player

Transfer your recordings
to computer

AN '

L

Drag in GPS Player




GPS Player ( PC)
— e

USE YOUR GPS PLAYER

— Footge Track

File Name File'Siz

004168.MP4 | 5572 MB

Choose to see your
Front / Rear View

See your Speed and Location

USE YOUR GPS PLAYER

Watching Front & Rear
at the same time

» o

Video playback speed » O Singl

Front \ ﬁ

Foider
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Trouble Shooting
—— e

ULTIMATE SOLUTION

> Use a pin or needle to press the reset button on the back of the
mirror.

> Unplug all the accessories of camera and charge to see if it works.
> Check your SD card is U3 Class10, if not,please change or leave
message to us to get it.

> Try different charging ways to see if the camera works.

> Update the latest firmware: https://www.redtigercam.com/pages/
firmware-1

* Update steps

Check your current version number.

Format your SD card and Insert the SD card into your computer with
a car reader.

Download the firmware to the computer and Unzip the folder.
Transfer the files to SD card.

If the method above didn’t solve your problem, feel free to contact
us and please leave current address
which is needed if the camera needs to be replaced later.

> This solution could be dealing with multiple problems > Won't

turn on > Restart it self > SD card error
> Can't auto recover > Can't playback
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Customer Service
—

WORDS FROM HEART

‘ Since our products are related to the safety of customers, we are
committed to producing the best product quality and high-quality
after sales support.

In view of no product is flawless, we sincerely believe the true
measure of the company'’s character is what it does *after* its
product does not meet expectations, we feel sorry for those
customers, but deeply grateful for them to make us one more
step closer to your most trustful automotive after-market brand.

We are willing to provide 1 month free return for your product, 1
year limited warranty, and lifetime technical support. Your product
is guaranteed to be free of defects in materials and products from
the date of purchase. In addition, you can also exchange your 1
year old product for a discounted price by contacting us online.

Behold the motif of complexity to us, simplicity to others, it's such
a pleasure to listen to your advice, and we will promptly address

any problems that arise.

Redtiger Customer Service Team.

[ |
N’
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Customer Service

Facebook

Email

O,
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WhatsApp

i

After sales: support@redtigercam.com

Business Cooperation: contact@redtigercam.com
Customer Phone Service: +1 888 966 8028 (US)

Instagram: @redtiger_dashcam
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Product Information
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Product Specifications

ltem Name

Model
Display/Touch Screen
Display Resolution

The Speaker

Software Support
Language Support
G-Sensor

Loop Video

Recording Function

Front Camera Video Quality
Rear Camera Video Quality

Working Voltage

32

> 11.26" Stream Media
Dash Camera

> REDTIGER T27
> 11.26 Inch

> 440*1920

> 1W 8R

> Multilingual Translation
> Yes

> Yes

> Yes

> 3840x2160/ 2560x 1440
> 2560x1440

>5(V)



Product Information
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Features

Rearview camera >WDR AHD

Full Screen Touch > Yes

GPS Trajectory > Yes

Taking Pictures > Yes

Camera Rotation > Yes

Automatic Astern View > Yes

Video Format > MP4

Image Format > JPG

Storage Compression Mode >H.265

ACC > Support ACC control of
Hardwire Kit

Working Temperature > -4°F to 158°F
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About Us

In an automobile-interconnection era,
everything about charm journey is within the reach of eyes.

Product and service are the foundation of Redtiger.
We have an expert research and
development team of "self-driving experts".

Based on the personal needs of users,
we use technology to drive product innovation.
In the future, we will continue
to explore the boundaries of tech to open up
a broader vision for driving.



